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Quadcept

About this tutorial

This tutorial is designed to provide the user with an understanding of the basic operation of
Quadcept, fundamentals of electronic design and also to actually design a simple PCB from a
schematic. The content covers basic Quadcept functions as well as convenient functions to shorten

the time of electronic design.

For more details, please refer to Quadcept online manual.

http://www.quadcept.com/en/manual/
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Screen Layout

This is how the Quadcept screen looks like:

TTmportT

Window
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M Design Area

This is the main design window.
B Menu Bar
Various functions are available in the pull-down menu.
HRibbon Menu
You can execute the function with a click on the icon in the ribbon menu.
Ribbon tabs including icons in the tabs are customizable.
M Toolbar
Icons can be grouped together.
Icons in the toolbar are customizable.
B Status Bar
Current design work status can be viewed or changed.
M Sub window
Various contents of such as properties, project or component can be viewed in the window,

and also select show/hide as desired.

X The display position and shape of design area, sub window and toolbar can be easily changed
or return them back to the default setting. For more information, please refer to our online

manual.
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Customizing Menu

When you change your CAD system to a new one, it is essential for designers that its operational

feeling is the same as the familiar CAD.

That’s all the more reason that Quadcept allows you to customize the ribbon menu, toolbar and

shortcut keys. You can create your original easy-to-use menu to shorten work time.
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Customizing Ribbon

You can add/delete ribbon tab or menus, as well as change the size of the icons.

Add a ribbon tab

1.  Menu bar [Settings] - Select [ Customize Menu]
2. Click [+] tab that appears on the ribbon menu
3. The [Create New Tab] dialog appears. Enter the tab name and click [OK] .

Quadcept i
% r’} P

-
Create New Open ‘
hd v

oK Ca |
I L ok J[ cance |

~ - |23 .
‘V] 7} (% meort *To delete a ribbon tab:
N, | [E28)
| Export »
Create New Open
v v

— Click [x] that appears next to the tab
Fle x (U Qg + 4 ] that app

[ settings]1-> Selectl Customize Menu]
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Add a menu
1.  Menu bar [Settings] - Select [ Customize Menu]
2. Select the icon you want to add from the [Customize Menu] dialog. Drag and drop into the

ribbon menu.

Quadcept rie  Window

A
Creats New
-

File = i User x

2 open Drag & Drop

Lm0 ) e Meny

=il Property
B
Crrag faverite icons intc the R
e’ Edit
3 : 24 Creata New
: Diraw — =

'“::" Schematic E? —

L - PR L | - a
E Create PCB Import
@ Panel =7 e
a, Project i Close

3D Close Al
Q'!* Window E Ssve
e ) Saftings E‘ Save As
& File Szve Al

Q_llﬂdCBpt File  Window Seftfings
&) i 8 [ Drag the icon
_ outside the
Create Naw | Open .
= g ribbon menu

*To delete a menu:
Drag and drop the icon outside the

ribbon menu.
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You can add/delete toolbars or menus, as well as move the toolbar to a convenient position.

Add a toolbar

Menu bar [Settings] - Select [ Customize Menu]

The [Customize Menu] dialog appears. Select <Toolbar> tab and click [New] .

The [Create New Toolbar] dialog appears. Enter the toolbar name and click [OK] .

The new name will be displayed in the [Toolbar] tab and the new toolbar appears around

the bottom left corner where the default position is.

Customize Menu =]

iz [ Tosiear

Enabed | Name

T |

Create New Toolbar x

Meny Tacloar

[ Enabies [ Hame

Default

*When a new toolbar is created, you'll see
the toolbar name in the [Toolbar] tab and
the new toolbar appears around the

bottom left corner.

O Commend | |E ERC Resuits | [EIDRC Resuits| | TR A

Jos|

The newly created toolbar

X0 ¥:0

Customize Menu =]

Meau | Toolbar

[ Enablea [ Name ]

E Defaut

Use Derault | New ||| Deiete

* To delete a toolbar:

Menu [ Settings] - Select [ Customize
Menu]

Select the toolbar you want to delete in

the <Toolbar> tab and click [ Delete] .
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Add a menu
1.  Menu bar [Settings] - Select [ Customize Menul
2. The [Customize Menu] dialog appears. You can drag and drop the icon you want to add in

the toolbar.

Quadcept Frie Wwindow Settings

4

Create Mew

Spen Drag & Drop

- L=l | e i
S il eny
File X i User =
et | F‘mp&r‘qr
G
Crag faverite icons nte the F
&
EAiE 84 Creatz New
=5 Ciraw e
Create Schemabic V} Sl
LISl S0 L E
E Creats PCB e
Panel Expert
a Project @ close
D Close Al
@'t* Window E Szve
o Settings EI Save As
&S Fil= Save All

*To delete a menu:

&

Drag and drop the icon outside the

&
toolbar.

e
=

; Edit

Craw

@k Create Sci

i Create PC
ﬂk rea
3 Panel
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Using the Mouse

Scroll the design area
You can scroll the displayed area of the document in the design area. Click and keep

[ the right mouse button held down while dragging the mouse] to the desired direction.

@0

Zoom in/out the image, Fit to screen

On schematic, PCB and component creation screens, the display magnification of the document can

Zoom in Zoom out

be changed.

* There are three types of shortcuts for fit to screen;

1. Whole drawing : [Keyboard [1] ]
2. Selected object : [Keyboard [2] ]
3. Board outline : [Keyboard [3] ]

13
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Filter Function

The filter function enables you to limit the selection of various objects (component, symbol, line,

rectangle, wire etc.).

Doing Filter

The filter is enabled when [Enable Filter] around the top left corner is checked.

1. Menu Bar [Edit] >Select [Filter]
2. Check/Uncheck [Enable Filter] around the top left corner.
3. Choose the target objects.
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S SR
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: SR
SaaiSeseees el
v Symbol Image fottotototetatetstotetototets
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[Setatetatetatetitotetitotatoret
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Junctian Attribute e et e o %
RSS!
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Bus e
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1

*The filter dialog can be closed while the filter is enabled so that it doesn't get in your way.

However, you should be aware which objects are set as filter enabled when you close the dialog.
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Setting a Filter Group
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You can set a filter group by clicking [Filter List] around the bottom left corner and select [Edit Filter

List]. Setting a group filter enables the use of keyboard shortcuts.

Edit Fiter x

Filter List i
¥ | Obisct v | Draw
Pin Line
P point Rectangle
Powar Supply Polygon

Fort
Port kadrass
v Symaecl

v/ Comsgnent

Wire
Junction
Bus
Lase
Hote
Brrew
Free Line

Singla Paint Grounding

Circle

[Ceoe Jlosen] [ useoem ]|

15

(& Enable Filter
v | object v | Draw
v Pn v Line
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v Power Supply v Polygon
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+  Port Address v | Arc
v Symocl v Image
v Ccmpenent v Text
v Wire  Reference
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v Bus
v Lade
v Note
v Arrow
 Freeline
 Single Peint Grounding
Bl Add current filter to the list Ctrl+A
Edit Filter List Ctri+E
All Items 1
Component 2
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Text 4
Draw S
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Stroke Function

The stroke command is the convenient Quadcept's original function.

You can register frequently used icons in the stroke command. The registered icons on the circle
command appear by clicking the scroll button on the mouse, allowing you to instantly select the
task you need while designing. By using the stroke command, you will be able to substantially

reduce mouse movement.

1. Press and held down the scroll button.
2. The stroke command appears. With the button pressed down, navigate the mouse pointer
to the desired task command.

3. Navigate the mouse pointer onto the icon to select. (Release the scroll button to cancel.)

CLK

VREF 33—_[_

Avbe
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Customizing Stroke Menu
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You can add or delete menus on the stroke function. Up to 32 commands can be set at each phase

of design process using Ctrl, Shift and Alt keys.

Menu Bar [Settings] - Select [ Environment Settings]

Under the Stroke folder on the left, select the phase of design process you want to

customize.

Select the tab you want to set.

Select the number of commands (4 or 8)

Select the icon from the right list and drag and drop it on the stroke command in the

middle.

17
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Schematic Design Flow

This flow describes the basic phases of the schematic design.

The objective is to output netlist.

B Schematic Design Flow

1. Creating Component (Pin + Symbol + Register Component)

First of all create component data required for the design.
l You can make component by creating pins & symbols and registering the shapes &

information.

2. Placing Component

Place components on the schematic.
It is asked to place component in a way the subsequent wiring task can be handled

efficiently.

3. Wiring

l This wiring information is output as netlist.

4. Verifying Schematics (ERC/DRC)

l Perform the Electrical Rule Check (ERC) and Design Rule Check (DRC) .

5. Output (BOM, Netlist and Print)

Output the components used, their information and the netlist which contains the
connection information from the completed schematic.

Print the schematic as you want.

19



Concept of Component
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The shape of component, its internal attributes and other information are defined and registered as
Quadcept component. Firstly, create the symbol (shape of schematic component) and footprint

(shape of PCB component). Then, register them with links to the attributes and other information.

What is a component?

It consists of

Reference + Attribute information + Pin information + Shape on the schematic (symbol) + Shape on

the PCB (footprint)

20

Component (741L.508)

The following information can be set up into the Quadcept component.

Component Name (74LS08)

m Reference

Ul

Reference text of
component can be set up.

m Value Information

Maker ON Semiconductor
Cost 82

Stock 2,000
Discontinued | May 2012

Component attribute information
can be set up.

m Pin Information

Finhumber | PindMame | Elecrical Swap
1 1A Imput | SWAP/ASL
2 2B Imput | SWAPR/A/2
3 1 output | SWAP/A/3
4 28 Imput | SWAP/BEf1
14 WoC Power

Pin information included in
component can be set up.

- PinNumber - Electrical Ploperty
- PinMame - Swap

B Symbol

e ey

Gate A | 0 = | 4= [T p-
X B Alternate o il
e I

Gate B - — | b
i Alternzte S

Gate € | i | «——> | i
s alternate =

Gate D | .- —p f_’j Yo
o Alternate —

Component shape on schematic is
created as a symbol, and register.

= Footprint

Component shape on board is
created as a footprint or
IPC footprint, and register.
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Component

Mm_
= & 40
-p]ll DIP 14Pin-2.54p-7.62w

%

5§ g

Pin Information

(& Set as Unmounted Component

| @ Reference | ‘ (GEchuted from Rembering

(&) Set as Mechanical Components (excluded from netlist)

Attrioute

& Value

@ Package

& Large Category
@ Small Category
& Maker

@ Part Number
& Shape

@ cost

Attribute
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Shape of Schematic Component

Create symbols (shapes of component) to place on the schematic.

A symbol (shape) can be shared among components. All you need to do is register it as a

component. When you want to change the shape of the symbol, all the components linked to the
same symbol can be changed all at once.

*Pins are needed to create a symbol so we have prepared various pins for you in the [Sample] folder.
You can save time using those ready-made pins as you don't need to create a new one from scratch.

*Sample pins : Ribbon <Draw> - Select [Pin] - [Sample]

Creating Symbol

Create a symbol (shape) of component to place on the schematic.

1. Open asheet to create the new symbol
Ribbon <File> - Select [ Create New] > [Symbol]
2. Create the shape of symbol
Ribbon <Draw> > Use [ Line] or [Rectangle] or [Circle] etc.
3. Place pins
Ribbon <Draw>-> Select [Pin] and place pins
4. Set origin point
Ribbon <Draw> > Select [ Move Origin Point] and place

5. Save

Shape of symbol

22
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You can create your own pins as well as use the ready-made pins in the [Sample] folder.

*Sample pins : Ribbon <Draw> - Select [Pin] - [Sample]

Open a sheet to create the new pin

Ribbon <File> > [ Create New] - [Other] >Select [Pin]

Create the pin shape

Ribbon <Draw> - Select [Line] or [2 Point Circle] etc. and create the shape

*The square in red is a pinpoint where wire is connected to on the schematic. Its default
position is at the origin point.

Set the origin point

Ribbon <Draw> > Select [ Move Origin Point] and place it

*This origin point is the reference point when moving pins. It is easier to handle when
placed on the opposite pin point.

Place its pin name and pin number

When selected, its origin point (a green point) appears. You can drag/move and place
objects using this as the reference point.

Save

23

.
.................................................. PinNo

PinName 5

R R R
The origin point (green point) appears
when the pin name is selected.
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Rotation and Mirroring
Pin and text can be placed in the direction you want by rotation and mirroring features.
*You can also use the rotation feature when placing components on schematic or footprints on

PCB.

Rotation (in 90 degree increments)

When the object is in a movable state:
Method 1. [Right click] > [ Move/Rotate/Mirror] - [Rotate]
Method 2. Press [R] key to rotate Mirroring

When the object is in a movable state:
Method 1. [Right click] - [Move/Rotate/Mirror] - [Mirror]
Method 2. Press [M] key to mirror

Rotated by 90 degrees

PinName 01- ‘

PinName 01—5

Mirrored 180 degrees

PinName {)1—E - 310 PinName

24
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Registering Component

Create components to place on schematic/PCB drawings; register the shapes of schematic (symbol)

and PCB components (footprint) as well as their internal attributes and other information.

1. Open asheet to create the new component
Ribbon <File> > [ Create New] - Select [ Component]
2. Set Reference
3. Input attributes
Click [Read Attributes] and read in from <Attribute Category> or click [Add] and select
the attribute and enter the value in the <Value> field directly
4. Register the symbol (shape of schematic component)
Double click and open [Select Component] dialog and select the symbol
5. Register the footprint (shape of PCB component)
Double click and open [Select Component] dialog and select the symbol
6. Save

Ribbon <File> > [Save] or [Save as] Select a directory and save it with a name

Symbel List crribute. N[LPin S swap b
: Componentl
: = i ﬁ Reference D [ Excluded from Renumbering
= NEW (2] Set as Mechanical Compeonents (excluded from netii
(L] Set as Unmounted Component
3
Read Attribute
Attribute | value
& Value
(@) cost
[+
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Attribute
You can set the specification, maker or other necessary information.

By checking the boxes on the left, you can show/hide the attribute on the schematic.

Input by setting attribute in the Attribute Category
You can create and manage attributes efficiently by setting them in the Attribute Category in
advance. Some attributes, based on each component characteristics, are already registered as

default settings.
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How to add/set attributes

The [Add Attribute] dialog will open. Click [Edit Mode]

The [Select Attribute Category] dialog will open. Click [ Setting]
While "ALL" in the <Component Attribute> is being selected, Click[ Add Jat the bottom of

Enter the attribute in the [Attribute List] directly and click [Enter] key

1. Click [Read Attribute]
2.
3.
<Attribute Categories>
4.
5.
click [OK]
6.
7. Click [Apply]

The attribute is added in the [Attribute Categories]

What you entered will be displayed in the [Add Attribute] dialog Select the attribute and

Symbol List

(0 Excluded from Renumbering

(0 Set as Mechanical Components (excluded from né
(0 Set as Unmounted Component

asripute NCRmLASwap

= & Componentt

O]

0 Exciuded from Re:
) Setas Mechanical

]
ents (excluded from

a7 not In the category

]

ceribute List

Frequency band
Driving votage
Isolaton voltzge

Rated ge/current
Ratad col voltage

Number of poles

Average rectified current
Forward voltage

Forvard current

) Componen Attrioute

Sove Sesings | Read Settings

| T A

s =
@ reence e

=]
[ setas| Acribute List

a Name

5
[ox J)Came)

==

Attribute Categories: Refay

Show

Attribute value

Added attribute
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vk W

How to add/set attribute categories

1.

Click [Read Attribute]

The [Select Attribute Category] dialog will open. Click [ Setting]

Click [Add] at the bottom of [Compone

The [Add Category] dialog will open Enter a new category name and click [OK]
The new category is added in the Attribute Categories under the [Component Attribute]

*You can select what attributes to be used in the new category by checking the [Show]

nt Attribute]

field of the [Attribute Categories] on the right
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Azrioute N Pin. N[ Swap

= @ Componentl

=]

‘ @ Reference (& Exciuded from Renumbering
| [ Setas Mechanical Components (exciuded from
Select Attribute Category X

@ Delete attrivutes that are not in the category

Attribute
@ Value
@ cost

Atiribute Categories

Pnctocoupler
Transistor
Switcn

Reay

I

D

A+
(e semnes | [ rasa swines |
Conce
O
T
e ro— =
e T |

Component Attrisute

fes: User:

Atibuse Categaries

Show | Auribuce value
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Creating Schematic

This section describes the schematic design flow.

mStep 1. Creating a New Schematic

On Quadcept, a schematic (as well as PCB) always has a parent folder called Project. You can save
multiple schematics in the same project so that the BOM and netlist can be output per project.

The opened project content is shown in the <Project> window on the right (default position).

Open a new schematic project sheet:

Ribbon <File> > Click [ Create New] = [Schematic Project]

*Drawing frame is needed to create a schematic. We've prepared the frames of various sizes to
choose from. You can save time using those ready-made frames as you don't need to create a
new one from scratch. We'll use default pins on this training as well.

*On how to create a drawing frame, please refer to [Create Drawing Frame] in the online

manual.

*Stored schematic and PCB in the project folder are paired; therefore the same reference cannot be
used twice in the same project.

You can also check what has been modified in the designs.

Project L1

B *What you can do with the project
[ Crez= hew | [(0o=n | 1. Managingmultiple schematics and PCB data (Netlist
File Staie
= Fl SampleProject 4 OUtpUt)
W Sheetl . 2. Cross Probe of schematic and PCB (Annotation and
[ Sh=etz [
(B Pce: ] = transfer)
HEERET [

Storing related files (Netlist, BOM, etc.z)

4. File management and print per project
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mStep 2. Placing Component

Place components on the schematic in the following way.

Leading edge
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A

Ribbon <Draw> - Select [ Component]

Select the directory and choose the component you want to place

Select the component with [double click] or click [OK]

The component is attached to the mouse pointer. Click anywhere on the sheet to place it.

You can continuously place the same component with a click, or press [ESC] button to exit

*[Power] is also placed in the same manner.

Quqdcspt File Edit Draw Create Schematic Project ‘Window  Settings efaultSettings/Samples/SampleProject/Sheetl (S3a27545abae2a1d50078e82/53a27534abae2a1d50d78e81)
— 1
bl # @C AT $o [ b sse winna (o1 -+ 2 | Memo~
I o NGE = s Parztie! wire T 4 Move Origin Point
Select | Line Component | Symbol  Device Block | Wire | Bus  Lapel Power Supply Port o 50 P o
| (P2l ~ Juniction £ single Point Grounding
oraw Geer
Property 4 Project "
Place Component a x
- A Informati B
ggregate Information G
Components 0
= e
kit . File | stase
mlects = T Library Bl =
Drag Move Enabled = F: i
Select Compenent P Tnvaiid - B Sheesz [F]
Setect Component P Tnvaiid Al A @ pcez |
HE Panell =
sample_doc. bt
b sample.dxf
"k samole.pdf
Preview. 3
= @ DIF 14Fin-2.5
=
& Include Subdirectories
B
3
(MesBBEaa®
i ISt Page. %[ @ Sheets x | [ETSheseE =] | 4

[Bcommand| [BERC Results | [IDRC Resuits | [EIMRC Resuits || Search Resutts| (W Desion instructions|

Current Laver |

T[] LeverTyoe [

[~ Previous Laver :

@GR 252

=] & Gupe[127

X:17.178229 ¥:296.033627

Not Selected

Thers is no select=d object.

User ID : master

1]

F10R1 R
- 10R2 1 P
— 10Rz
:-;— 20R1 o
ol 20RZ 2
o] 20R3 a
— 1N W =
Bluoe  wes e

lue

Place it with a click!

- ™
= oo — o
o X ror
[ R [ R}
- oo

T o
| 7.

WSS

“wialue

20R3
MW
WD

2

4
—

5
—

1
12
1z |
13
13
B
14

Rotate/Mirror and place
[ Right click] > [ Move/Rotate/Mirror] = [Rotate]
[Right click] > [ Move/Rotate/Mirror] > [ Mirror]

Press [R] key to rotate

Press [M] key to mirror
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mStep 3-a. Wiring

Leading edge‘@ solutions

Quadcept

Connect pins of components. This task is important as the connection information will be output as

the netlist.
1. Ribbon <Draw> - Select [Wire]
2. Click the pinpoint to start connecting
3. Click the pinpoint to finish connecting

*The pinpoints will disappear when pinpoints are connected correctly.

*You can start wiring at places other than pinpoints.

Double click to exit the wiring mode when you don't connect the wire to a pinpoint.

31

Value

U1 u2
21 10R1 -2 qoRi
4 1 1or2 1B L4 ] 4omo 1 pl
24 10R3 @ @2 10rs
U1 20r1 U1 20Rr1
121 50r2 2 b9 121 50r2 2 p19
131 o0r3 131 50r3
ol Y W P 21 Ny W p
“lvop vss |- “lvop vss |-
Value alue
Click on the wire and a junction is created.
U1 U2

1 10R1 > 10R1
21 10r2 1 p° 4 1 10r2 1 pe
21 10R3 _+a5— 10R3
U1 20r1 U1 20Rr1
121 50r2 2 plo 121 50r2 2 pl9
131 o0r3 131 50r3
I Y W p 21 Ny W p
“lvop vss |- “lvop vss |-

alue
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How to draw wire/line

This section describes various ways to draw [Line] to create shape or [Wire].

Drawing a corner

1. Ribbon <Draw> -> Select [Wire] or [Line]
2. Click where you want to start

3. Click on the corner
4

Click where you want to finish (Double click when in the Line mode)

Click to start e
Click on the corner

__o
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How to change the bending angle

[Right click] - Select [ Change the Bending Angle] or press [S] key

*You can check the bending angle in the [Property] window.

45 degree 90 degree “

How to switch angle

[Right click] - Select [Switch Angle] or press [X] key

B HHEE

Return to a previous state

[Right click] - Select [Pushback] or press [Back Space] key

L L

-
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Edit line width

[Right click] - Select [Edit Line Width] or press [W] key and enter the desired line width

EZo
L

-

Cancel drawing

[Right click] - [Cancel]l or press [Escape] key

-
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mStep 3-b. Auto Wiring
By specifying a start and finish point, it connects the two points automatically getting around

obstacles such as other components and wires.

1. Ribbon <Draw> - Select [Auto Wiring]
2. Start wiring by clicking the start pinpoint
3.  Finish wiring by clicking the end pinpoint

35

ut U2
> 10R1 >4 10R1
21 10R2 1 pe 21 10Rr2 1 P
21 10R3 2 10R3 Tt
//T
U1 20R1 1] M
121 s0r2 b0 271 20Rr2 o ol
121 o0rs 131 20r3
Rl Y 7 P L1 Ny W p
i 7 14 7
Q@0 vss |- Ylvwop vss e
Value Value
11 Lz
2 1or1 < 1or1 @
=2 1oR2 1 p 2 1oR2 T o h—
2| 10R3 21 10m3 |
L
|
U1 90r U1 20m
121 s0r2 > pld 121 s0r2 2 pi8
1B 1 o0pa B 1 20m3
i Y ™ pe 1 iy W P
CH o o ER G ) o BN
Yalue “alus
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mStep 3-c. Bus/Parallel Wiring

Connect multiple wires in a bundle.

Ribbon <Draw> - Select [Bus] to create bus routing
Ribbon <Draw> - Select [ Parallel Wiring] and select multiple pinpoints
by mouse drag to start.

Connect multiple wires to the bus routing

oA W e

When the wires are connected to the bus routing, rippers are automatically created.

CN1

=

L

NSNINRNNN

@ N O O | e N =

oo |~

e \ alue \
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mStep 3-d. Placing Label

Label the wires to identify where they are connected to.
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Ribbon <Draw> = Select [Label]
Enter the label name and click [OK]
Click on the wire you want to place the label

*By mouse drag, you can sequentially number the wires incremented the last number of

the label name by one.

O

o

Drag

[=-10 NI for R 5,00 Ry (S0 RN | G0N Fog

SOUNNNNNN

alue

CN1

Al

A2

A3

A4

A5

A6

AT

@ IN | || N =

A8

NSRRI

alue
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mStep 3-e. Placing Port

You can connect a wire to a pin on another sheet by placing the port on the schematic.

Port is like a warp point to connect the wire when using multiple schematics.

*We have also prepared various default port shapes. You can save time using those ready-made

ports as you don't need to create a new one from scratch.

Ribbon <Draw> - Select [Port]
Select the directory in which the port is stored and choose the port
Specify [Port Name], [Port Width], [Origin Point] and [I/O Type]

[ Double click] or click [OK]

The port is attached to the mouse pointer. Click anywhere on the sheet to place it

vk N e

i | Name | Upoated Dste | Hiszory
B & Samples [ EBIDIR 4/24/2012 11:43 ¢ | 1 changad =
(# [ UserDatas = BIDIRCIrcle 42472012 11:43 £ | 5 changed|
| 2 Left | 4/24; 34| 2 chang=d 1
| 2 LefCircle ["a/24 424 6 changed
| mant | 4/24/2012 11:43 4| 3 changed v

a0 ] I »

< A8 >

[ Include Subdirectories

eﬁ Port Name | A[1:5]

PortWidth [ 15.24 ] O Auts adiust
Qrigin Point |.-1| gn Center |'|
/O Tyoe |-.;ndeﬁﬁe.: Port |" |

@

*Setting Bus Rule
Bus rule consists of label identifier, label number range and operator.

This will enable you to connect the bus wire to another sheet.

Label identifier Label number range
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mStep 4. Verifying Schematics (ERC/DRC)

Verify schematics before output.
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vk W

Ribbon <Completion> > Select [ERC/DRC] - [ERC/DRC Settings]

Set each item for the rule checks

Select [ Apply] and click [OK]

Ribbon < Completion > - Select [ERC/DRC] - [Run ERC/DRC]

Check the results of [ERC]/[DRC]. When there are errors, correct them and repeat the above

procedure until all errors are corrected.

ERC/DRC settings

Settings

| Project.Schematic

& Color

= Chjects

X

= RN W'
| | ERC - Inconsistent Net and Bus Rule ey \ m
= T

CHE =1

[ SEvE Samngs ][ Read Ssttings ]

& BOM g Error Type Check Contents
1 Mema : = Net connection that violates bus rule.
=1 ERC v | @ Error Twe-oyis characiers In net nams.
1 Inconsistent Coemponent/Reference Rulg .r\/ _0 Errar n Sams net power supplies b_u'c different symbal.
1 Iniconsistent Wit and Bus Rule |‘{ @ Error : Same pine connected to different nets.
~1 Undefined/Unconnected Objzcts
@ Pin Conmection Matrix
=1 DRC
21 Clearance
(& Distance
i Design Instructions
&0 Design Instructions
AD
Al
AZ
B

q ot [ covee ] [roon]]
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ERC/DRC Results

Leading edge

solutions

Quadcept

ERC/DRC correct error points after verifying. (double click to jump into that point)

Quadcept Fle  Edit

# Edit Drawing Frame « | ¥ Assign Footprint.

Compietion
Property g
-~ Aggregate Information =
Componants £
Pins 89 iz
Cost o '&
~ Objects
Crag Move Enabied -
Select Component Pif Invaiid =
Seiect Componant 71l [nvaid o= £

1% Por: Address ~ B’ Update Componants

R2
47k

Draw  Create Schematic

% Renumber Reference | $F Replace Symbol to Companant | (] Undate Device Black.
@5 Update Davice Port

Project Wi \'nﬂé v Settings

80|
e

C1

s/ImportTest/4LayerSample/ALayerSampleSCH (4f4dc77e0r554e1ac084c2 26/414cobdd604092175838a437)*

=3
o

BOM | Export Netfist | Transfer to PCB | Transfer Design Instructions.

- t

Place PCB Companent

= & o el
§® Ciear Placed Marks

Project

Annotation | Poan.com

a x

CH1
ksl
7
5]
%! 3
= Panell
n“ﬁL sample_doc ot
5N |87 sample.dxf
[ = cample.pdf
' fil H rce2*
F 8
5
yd 10

State

ERC Restis

& Emor (117 W Warning (0)

Error; 12 (not yet: 11 aporoved: 0) Warning: O (not yet: 0 spproved: 0} Delete: 0

[ Update List | [Delete From Uist| [Dispiay Settings| |

Save File

| o, « | Check Type | Targes 1 Target 2 Sheet Address Response Sta| Comment

@ 1 Unconnected Pin 4LayerSampleSCH -

e 2 Unconnestad Pin L5 SlayerSamplescH B Motyer  |=]

9 3 Unzennastzs Bin cNL4 alsyersamplescH B Motyet  |=]

o 3 Uncennastzd Pin IcL4 sleyerSamplesce B4 Notyet || -

® s Uncennactzd Pin N13 sleyerSamplestH | B4 Notyet ||

® s Uncennzstd Pin IcL3 slzyerSampleste B4 Motyet || A

- . — = = = -
Current Layer | [=] vLayerTyoe [ [=] erevious Layer : & GRID & Guioe
X:138.074272 ¥:107.434517 Mot Seiecten Thers s no selem=d oject. User ID ; mastar
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mStep 5. Export BOM

You can export the component information used in the schematic and create the BOM which

contains the component and attribute list.

A w N

Ribbon < Completion > - Select [BOM]
Select [BOM Settings] and set what you want to output
Select [Export] and save dialog appear

Select where to save, name the file and click [OK]

Quadcept File Edit Draw Create Schematic Project Window Settinas  s/ImportTest/4LayerSample/4LayerSampleSCH (4f4dc77e0fS54e1ac084c226/414c9bdd604092175838a437) *
1

Eﬂ e ] - @° Place PCB Component @i B
80M

42 Clear Placed Marks
Export Netiist

&3 Renumber Reference | 3£ Replace Symbol to Component |[2] Update Device Block
5 Port Address ~ [E° Undate Components g3 Update Device Port
[#) Edit Drawing Frame ~ | T Assign Footprint

ERC/DRC Transfer to PCB | Transfer Design Instructions | Annotation | Pozn.com

Property « Project »
~ Aggregate Information e ==
Comzonents ] BOM : 4LayerSample o x
s 3
Cost 0 o
[ Reference | ComgonentFileNd Quantity | Value | cost | e ——
~ Objects e . i 3135 £1% = M SampleProject @
Drag Move Enabled - = = B — 68 Sheet: @
Select Component Pif 1nvaid = | 1 = - = @ Sneeiz @
Select Component Pif 1n - 1
e 1 24FL2-5M2-GB- T e g
= E2 Panell
2 0.1u
e 1 sample_doc.txt
3 A| sample.dxf
=% sample.pdf
[ Sl 4LayerSample @
| [ 4LayerSampleSCH* @
[ sLayerSamplePCB &
Preview >
3
oo N|Loeee
wr e vouT
[ o [ S J7
L@ €« v B Aaad g =
s ] [EPes 5] [ PR (A erSame s | <Lversamoe = [ <[ [«

S
B command| [@ERC Resuits| [ DRC Resurs| [ MRC Resutts| [ Search Resutts | [@ Desion ions|

Current Layer [ [) LayerType [ [=) Previous Layer : @ GRID 252 =) & GuIoE [127 I¥)
X:139.823857 Y:170.724852 Not Selected There is no selected object User ID : master
Settings x
| e |' | m wm
&l Coelor

Afiribute List
Aftribute
= & ::;w & Reference (L] Show Unmeuntsd Companents
B &
1 Inconsistent Compenent/Reference H il ComponentFileNarne | (R L R
5 U ) i-) Citation [R1RZR3UL L
M Quantin Citat] RLRZR3,U1U2Z]
ed/Unconnected i Vaisz @ Group [R1-3,U1-2]
) Pin Connection Matrix &g cost
= {3 DRC
2 Clearance
() Distance Check the attribute
[ Dasign Instructions settings for output

(2 Design Instructions

40 1

[ Save Setungs ][ Read Settings M =

[ ex ][ eancei | [ aspiy
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mStep 6. Export Netlist

Output the netlist (connection information) from the schematic.

1. Ribbon < Completion > - Select [Export Netlist]

2. Select output format
(Currently available formats are CR-5000 PWS(CCF), Telesis, PADS(v4-5) ,EAGLE and
Connect to NET CHANGER)

3. Select where to save, name the file and click [Save]

Project Window  Settings s/ImporiTest/d4layerSample/dlayerSampleSCH (4fddc77e0f554e1a

[#] Update Device Black
i Update Device Port

CR-5000 PWS({CCE)

Telesis
PADS(w4-5Y
EAGLECSCH)

Connect to NET CHANGER

*Connect to NET CHANGER
Make the netlist by connecting to NET CHANGER. Export of the netlist files in a compatible format
with NET CHANGER is possible.
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About NET CHANGER
NET CHANGER is the tool that Quadcept Inc. provides free of charge. It is easy to use and allows you

to convert or compare netlists on the web!

https://netlist.quadcept.com/

NETCHANGER £

Net list Conversion &« Comparison

FREE USING CLOUD SERVIGE

\;_‘_‘ NET CHANGER

NET LIST CONVERSION & COMPARISON
\

Tme

You can converi your electronic 3 You can compare schematics

et & Wherever the Infenet is available, .
CAD netis! CAD formais! 3
'AD netiists into other CAD formals! T e R before and after afferations, and also can

S e e reverse compare schemalic and PCB design!

» conversion » comparison
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ep 7. Print Schematic

t the schematic.
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Ribbon <File> - Select [ Print]

Check the print settings in the [Print] dialog

Click [Print]

There are several ways to print out. You can print the design area as is (normal print) or

print per project as well as batch print various output/print.

Primt

] (eroperes]

ﬁin:er |Bu|'zi|J PDF Printer

Paper Size |A4 (W210 H257 mm)

£2

@ Fit ta paper
) Scaling | ao =

(& Fit to Brawing Frame Size

Offset X: |__: | & Centering
X | 0,00 | = [ Centering

Print Direction | Herizontal | ']

Caolor |CQEQ.’ |-]

Show Memc

Mema Layer |

Comment
Toda

Knowisdge

Print Targst

Nams | v |

Al zyersamplesCe [+

[C] Print Al Shests in the Praject
(O] Hide Gate Number
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Creating Shape of PCB Component (Footprint)

Creating Shape of PCB Component (Footprint)

Creating Shape of PCB Component (IPC Footprint)

Registering Component

Creating PCB
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PCB Design Flow

This flow describes the phases of the PCB design.
The objective is to output CAM (gerber data).

M PCB Design Flow

1. Create Component (Footprint + Registering Component)

' First, prepare component data for the design.

To register a component, it needs to have a pad and shape.

2. Annotation

Quadcept allows you to annotate from Schematic to PCB.

3. Various Settings (Layer Settings, Design Rule Settings)

' Various settings are required to design.

4. Input Board Outline and Place Component

Place components in the board outline.
‘ It is asked to place components in a way the subsequent routing task
will be handled efficiently.

5. Routing and Creating Plane

Drawing the route and creating plane.

6. DRC/MRC

' Perform DRC (Design Rule Check) and MRC (Manufacturing Rule Check)

7. CAM Output

Export Gerber data or desired data from the completed PCB.
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Creating Shape of PCB Component (Footprint)

Create component's footprint to place on the PCB.

1. Open a new sheet to create a footprint
Ribbon <File> = [ Create New] - Select [ Footprint]
2. Place a pad
Ribbon <Draw> - Select [Pad] to place
3. Inputsilk
Press [L] key to set the current layer as [Silk] (or [ Right click] - Select [ Change Layer] and
set as [Silk]
Ribbon <Draw> -> Use [Line) or [Rectangle] or [Circle]
4. Adjust the Reference position
Move the reference [U] by mouse drag
5. Set the origin point
Ribbon <Draw> - Select [ Move Origin Point] and click on the desire point or while
selecting the object [Right click] - [Move Origin Point to Center]
6. Input dimensions
[ Create PCB] - Select [ Create Component Dimension Automatically]
7. Save
Ribbon <File> - Select [Save] or [Save as]

Select a directory and save it with a name.

Reference
U Padstack
HEEE

+

Origin point

CHEREIE

Dimensions
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Creating Shape of PCB Component (IPC Footprint)

Automatically create component’s footprint (shape) according to IPC standard.

1. Open a new sheet to create IPC footprint
Ribbon <File> > [ Create New] - Select [IPC Footprint]
2. Select [Category] and click [OK]
3. Set various settings
Check your settings with the preview
4. Save
Ribbon <File> > Select [Savel or [Save as]

Select a directory and save it with a name.

T IPCFootPrintl

Quad Flat Pack{QFP)

h Comman H Pad Details |
Component 4 Pad [ Genarsl [ Information

Pin Count ({total)}

Horizental Pin Count |20 Vertical Pia Count | 20

Pitch [0.65 |
[C Fiducial Mark [] Heat Pad
Format - | Minimum and Maximum Value |-|
Minimum Vatue Maximum Value

Bedy Width 16.8 17.2

Bedy Full Length| 16.8 7.2

Body Width 13.8 14.2

Bedy Length 15.8 14.2

Body Height 1.2 1.2

Lead Width 0.26 0.38

Lead Length 0.675 0.925

Stand Cff 0.05 0.05

Enter the dimensions of

the component
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Registering Component

Create component to place on design drawing (P.20), and register shapes of PCB component

(footprint).

Open a new sheet to create a component

Ribbon <File> > [ Create New] - Select [ Component]

Set Reference

Input attributes

Register Symbol (shape of schematic component)

Double click and open the [Select Component] dialog and select a symbol
Register Footprint (shape of PCB component)

Double click and open [Select Component] dialog and select a symbol
Save

Ribbon <File> - Select [Save] or [Save as]

Select a directory and save it with a name.

[E] Set as Mechanical Compenents (excluded from netli

Symbel List crribute. LB S Swan
Componentl -
= F NE ﬁ HA=ference D [ Excluded from Rgnumbering

(L] Set as Unmounted Compaonent

3

" Read Attrioute.

Aftribute | alue
& Value

(&) cost
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Creating PCB

This section describes the flow of creating PCB.

mStep 1. Annotation
Quadcept allows you to cross probe from Schematic to PCB.

Schematic netlists created with other CADs can also be read by the Quadcept PCB Designer.

1-a. When designed the schematic on Quadcept

1. Open the schematic you want to transfer
2. Ribbon < Completion > = Select [Transfer to PCB]
3. The PCB sheet is automatically generated. PCB components are placed based on the

schematic and connected automatically based on the netlist information.

Draw Create Schematic Project Window  Settings /Lirary/Sor s/ SampleProject/Sheet2 (53027545000e231050076e52/53027553ab0e2a1050078¢63) B

2]

Annotation | Poan.com

e 3 /_E
L. 3 | Preve
L) o
»
L.
T O e

Re s a0 ass

H‘ﬂswwaqe % | [ Sheeti= X [ ALayersampie = %] | o Sneez- x | [IPCE2R

| B Command | [@ ERC Resuits| [ ORC Resurts | [[IMRC Resutts || Search Resutts | | Design Instructions

Edit Draw Create PCB  Project Window

Numoer

[ Start Page % || ] Sheeti= yersample - = | | b Shestes * || [ PcB2~ [4]2]~

B MRE Resuits| [E Search &

[ B Command] [Blerc Resuits | [@oRe
c = L

Frld @ools ) @ootim 19 =

User ID ; master

¥:178.021654
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1-b. When designed the schematic with other CAD
The netlist to be read must be in Pads format. The footprints must be placed on the PCB design

sheet prior to the netlist import.

1. Ribbon <File> - Select [ Create New] - [PCB Project]
2. Ribbon <Draw> - Select the corresponding footprint shapes from [ Component] ,
[ Footprint] or [IPC] and place them

*Place the components in accordance with the netlist information to match the Reference
and pin number.

3. Ribbon <Completion> - Select [Import Net] - [PADS(v4-5)] or [Connect to NET
CHANGER]

4. Select the netlist in Pads format and click [OK]
The netlist information will be read to the placed components.
When an error occurs, the error message will appear. Resolve the issue or if it is not a

problem, click [ Continue] to complete the import.

Quadcept File Edit Draw CreatePCB Project Window Settings [Not Created] PCB2 (53a27545abae2a1d50d78e82)* _ B X

& Renumber Reference | gxg = = ] ] o) NC Dril = =] =4

[B° Upcate Components. it NC Drill List »

Pban.com | Draw 3D
mponent Coordinate Export v -

File ¢ Draw J Completion 4 User

Property

[ Aggregate Information

Components o

liﬂﬂﬂ@ﬁ@ﬁ{ﬁﬂiﬁ?ﬁﬁﬁi@ﬂ L

CNQ1

-
The corresponding footprints must x®

be placed on the PCB sheet prior to

the netlist import.

Hioanies
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mStep 2. Layer Settings

First, board layers need to be set before proceeding with PCB design.

1. Open a PCB sheet, and select [Settings] > [Settings] > [Layer]
2. Seteach layer in the [Physical Layer] and [Layer Settings] and Click [Apply]l - [0K]

Physical Layer Setting Screen

Set the physical information for the impedance calculation. The default setting is four layers.

Settings Z

Project PCB2. - - ¥
Layer F S/
_ e

Layer
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Col Dislectric d Digtectric|

Layer2

Leyers

Bottom

—_— =

(o senss | st |

Layer Setting Screen

Object layers are available.

You can also add a customized layer, set colors as well as set show/hide.
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Description of Layers

mSilk

Silk object layer for non-electrical objects such as reference, line, character etc.

mElectric
Copper layer for route, plane, pad land, via land etc. Electrical objects are automatically

placed on this [Electric layer].

mRoute

Route object layer in the Electric layer.

mCopper

Plane object layer in the Electric layer.

mPadStack

Pad land object layer in the Electric layer.

mViaStack

Via land object layer in the Electric layer.

mPaste
Metal mask and paste mask layer. When you enter the metal mask data for the SMD pad, the
object is created automatically on this layer. Objects such as line can also be placed on this

layer.

mSolder
Solder resist and solder mask layer
When you enter the solder resist data for the pad or via, the object is created automatically

on this layer. Objects such as line can also be placed on this layer.

mAssembly
Component outline layer
When you use the IPC footprint, the outline is created automatically on this layer. When you

create a footprint, its outline can also be generated.
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mKeepOut
Keep Out Area layer
When you set the Keep Out Area on other layers, it is created on the KeepOut layer in the
individual layer. When you apply the Keep Out Area to all layers, it will be created on the

KeepOut layer in the Other.

mDesignRule
Design Rule Area layer
When you set the Design Rule Area on other layers, it is created on the DesignRule layer in
the individual layer. When you apply the Design Rule Area to all layers, it will be created on

the DesignRule layer in the Other.

mDimension

Dimension layer

When you use [Create Component Dimension Automatically], the dimension is created
automatically on the Dimension layer as default.When you use [Create Board Outline
Dimension Automatically], the dimension is created automatically on the Dimension layer in

the Other as default.

mBoard

Board Outline layer. Draw closed graphics with line or arc.
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mStep 3. Design Rules
You can set the clearance, route width or other design rules to the net class (a specific group of nets

you selected).

Net Class Settings

Leading edge‘@ solutions

Quadcept

Open the PCB sheet you want to set
Ribbon < Completion > > Select [ DRC/MRC Settings] > [Net Class]

Click [Add] at the bottom of [Net Class] to add a "Class"

*At first, all nets are included to "Default Class".

Choose nets you want to add to the "Class" from "All Net"

Click [ <] to select [multiple selections available]

When you finish selecting, click [Apply] - [0K]
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Clearance Settings

Quadcept

1
2
3.
4

Open the PCB sheet you want to set

Ribbon <Complete> - Select [DRC/MRC] - [ DRC/MRC Settings]

Select [ Clearance] from the list on the left

Select <Advance Settings> tab, and click [Add] at the bottom of [Settings] to add a

clearance. "Settingl" is created.

*At first, all belong to the "DefaultSetting".

Select "Settingl" from the list, and set [Layer] and enter the clearance value in the
[Clearance Settings] matrix.

Select <Assignment> tab - Assign the clearance setting "Setting1" by selecting from the

[Setting]

The clearance "Settingl" is set.
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Route Settings

1
2
3.
4

Open the PCB sheet you want to set

Ribbon <Complete> - Select [DRC/MRC] - [ DRC/MRC Settings]

Select [Route/Vial from the list on the left

Select <Advance Settings> tab, and click[ Add Jat the bottom of[ Settings Jto add a route/via.
"Settingl" is created.

*At first, all belong to "DefaultSetting".

Select the "Settingl" from the list, set [Layer], [Route Width] and [Available Vias]

Select <Assignment> tab - Assign the net class "Settingl" by selecting from the [Setting]

The Via which uses "Setting1" is set.
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mStep 4. Drawing Board Outline
Quadcept recognize the line drawn on the [Board (type)] of [Other (layer)] as board outline.

Besides drawing a line, board outlines in DXF file or IDF file can be imported.

4-a. Drawing a board outline directly

1. Open the PCB sheet where you want to draw a board outline.

2. Press [L] key and set the current sheet as [ Other.Board] (or [Right click] = [ Edit Layer]
—set it to [Other.Board])

3. Ribbon <Draw> - Use [Line] or [Rectangle] or [Circle] to draw the line

Value

Bottom. Silk
Bottom Electric
Bottom Paste

58



Leading edge

solutions

Quadcept

4-b. Reading DXF/DWG data for a board outline

Open the PCB sheet where you want to draw the board outline.

Read DXF/DWG data

Ribbon <File> - Select [Import] > [Import DXF/DWG]

The <DXF/DW> dialog appears

Click [...] at the end line of [Input File] > Select the file to import

The layer names in the DXF/DWG file will be displayed. Select the importing layer
Specify where the layer to be imported on Quadcept:

Specify [Other: Board] in the Layer list and click [>]

Click [0OK]

Import DXF/DWG
port File | Cretis ek oLt - |:||
Import Settings Locatich
Uniz | @ Place to Origin Point ‘
Lin= Wigss [0.2 Taxt Line Width [0.2 &) Ptace Manualiy .

& Specify the telerance | 0.001 |%|

Import Layout

@ *MODEL_SPACE (o) *PAPER_SPACE
|
AEIDWE Laver Layer Azsigned Layer !
il Bottom Solder |
s

layer. Other Beoard

(]3]

1k

4| | j
[] Show only the lavers thet contain data [ oK ] | PR

59



Leading edge‘@ solutions
Quadcept

4-c. Reading IDF data for a board outline

1. Open the PCB sheet where you want to draw a board outline.

2. Read IDF data
Ribbon <File> > Select [Import] - [Import IDF]

3. The <Import IDF> dialog appears
Click [...] at the end line of [Input File] to open - Select the IDF file
Check the [Enter Board Outline] box >click [OK]

Import IDF X

Import File | C¥Lisersy ||

I g Import Board Outline I

pd Reflect Component Coording

DK

[ ALancel
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mStep 5. Moving Component

There are several ways to move and place components (footprints).

5-a. Move a component by mouse drag

1. Open the PCB sheet > [Settings] - [Environment Settings] - Select [PCB]
Check whether [ Allow Moving Objects by Dragging] box in the [Move] section is checked.

2. Dragthe component to move

Move by mouse drag
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5-b. Move component in Move mode

*The origin point of component is the reference point when moving components.

1. Open the PCB sheet - Ribbon [Draw] - Select [Move]
2. By click the component, it will be attached to the cursor

3. Click where you want to place the component

Edit Draw Create PCB Project Window  Settings [Not Created] PCB2 (53a27545abae2ald50d78e82)*

@ 5 g T |{Ecomponent | Pad |“Padd et —
@ (3 il =3 Footorint @ via |G Detete Net -
==y @ £ 1PC Footprint

User

Route.
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Pins 92
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["open | [Remave

"
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1
g
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User ID : master

* || [E3Lsyersample = | | [ PCB2~
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5-c. Move component by entering the coordinates
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*The origin point of component is the reference point when moving components.

i CSTCEXXMOOG

1. Double click the component you want to move - The [Component] dialog will open.
2. Enter the coordinate values in the X and Y fields around the middle of the [Attribute] tab
3. Click [0OK]
Component >
Symbel List Aribute NEERL.
= i X

@ Rererence
Layer |Tc.r: | 2 |
Angle [ 180 =

2] Excluded from Renumbering

[ et as Unmounted Componsnt
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&) Maker

oz
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5-d. Move by the center of the pad as the reference point.

*The center of pad is the reference point when moving components.

Leading edge@ solutions
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1.
2.

Select the pad of the component

Move the mouse cursor on the pad handle and drag
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5-e. Move by selecting the component in the Object window

*The origin point of component is the reference point when moving components

1. Open the PCB sheet and select the <Object> window. Assign a [Move] or [Move
Continuously] task to [Double Click]

2. Select the target component in the <Object> window and [Double click]

3.  When you navigate the mouse to the document area, the component will be attached to be
moved

4. Click where you want to place it
When [Move Continuously] is selected, the next component in the <Object> window

becomes movable automatically.

[Not Created] PCB2 (53a27545abae2a1d50d78e82)*
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5-f. Place (move) component from schematic
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*The origin point of component is the reference point when moving components.

If the component is within the same project, you can place (move) the component while checking

with the schematic.

A

Mark] is displayed on the component.

Open the schematic sheet

Ribbon <Completion> - Select [ Place PCB Component]

Click the component, which you want to place in the PCB sheet, on the schematic
Automatically switches to the PCB sheet. Place the PCB component as it is now movable

After placing the component, it automatically returns to the schematic and the [Placed
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mStep 7. Routing

Drawing routes based on the netlist information.

Routing Task

1. Open the PCB sheet - Ribbon <Draw> - Select [Route]
2. Start routing by clicking the ratsnest, pad with net information or the route in the PCB.
3. Draw the path by setting points with a click along the route. To finish routing, click or

double-click on the pad.

Quadcept File Edit Draw Create PCB Project  Window c]ﬂl.tngs [Not Created] PC|
% ‘3, / @ (5 g T iECemponent | ¥ Pad | *7 Add Net [ Parallel Routing Kesp Out Area =
. T &) (5 il =] §E Fectprint @' via [ Dele= Net - o7 Differential Pair Routes Design Rule Ares =
select Mave | Lina [# @ § 1PC Fookprint I Tune Route Lengths +
File ] Draw 4 Comp £tion  User
Property 1
- Aggregate Information =
Components o
Pins 92
Cost 0
Enablad ‘ hd
Enabled ‘ hd
0.2
Circle "
Line ‘v
0.20
Bending Angle 45 degrees v
Show Clearance Route -
Route Interpolation | Invalid -
Cig mot Allow hd
Routing at Pad Angle) 1nvaid = Start routing by clicking the ratsnest or
Wiz Rad:0. - pad with net information.

Tuning Shape 45 Degrees *Can be started on a route on the PCB.
Maximum Amplitude| 2,54

Gap 0.508

Trimming Length 0.25<
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Bending Angle of Routing

Bending Angle:
Press [S] key at the corner of routing, and change the angle to "45 degree","90 degree" or
"Free"
*Other methods: [Right click] > [ Change the Bending Angle] or [ Bending Angle] in the

[Property] window

45 degree 90 degree
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Switch Angle of Routing

Switch Angle of Routing:
Press [X] key at the corner of routing, and change the routing angle.

*Other method: [Right click] > [Switch Angle]

Before
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Placing Via / Change the Current Layer

When you change layers while routing, a via is automatically created.

1. Click where you want to place the via while routing

2. Press [L] key to change layers (or with a right click > [Change Layer D
3. Specify the layer you want to switch to the current layer, and click [OK]

*You can also place a via with pressing [ Tab] key (Move to Previous Layer) at the step 2.

*You can place via stacks and fix creating routes with pressing [V] key at the step 2.

Click and press [1] key at the point
you want to place via.

*Or [Right click] > [Change Layer]
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Editing Route Width

1. Click on the route you want to edit the width.
2. Press [W] key and edit the width (or with a right click > [Edit Line Width] )
3.  Enter the line width and click [0K]

Minimum Line Width

Default Line Width

With pressing[W] while routing, the Maximurm Line Width

line width settings window will appear.

Line Widtn [0.5

[ Route/Via Settings ]
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Convenient Functions for Routing

Here are some tips for routing.

Online DRC

You can check the DRC settings in real time while designing the PCB.
The reduction of work time and quality improvement is expected as you can check the DRC
settings while designing; the task previously done after the design is completed.
Toggle ON/OFF
- Toggle enable/disable with the [DRC] button at the bottom right corner.
- Select [Settings] > [Settings] - [System] = [Route]
Toggle check/uncheck [Enable Online DRC]

5| | B 4LayerSampie - | [ERPCBZE ] [r]=

+| [@MRE Resuits| [ Search Resutts | [WiDesign Instructions|
[7] Previousiayer: Bottom mm |v] @ CRID [252 ¥] @cumefoess  [=)

oute Please click naxt paint or double dick ta Ainish: (widtn =0.2, lengt =20.430057506, 4)X =2.885, dy =0.92) User 1D : master

*Objects which violate the clearance rule will be displayed as highlight.

Objects which violate the clearance
rule will be displayed as highlight.

& 6 B &

MRC Resuits| 1] Searen Resuits| M Dezion Tnstrucions

[ ~| Previous Layer : Bottom

User ID @ mastar
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Stop at First Obstacle

It allows you to stop at first obstacle while routing. So you can create the route with the

shortest path along other routes or planes taking into consideration the DRC clearance settings

and avoiding obstacles automatically.

Toggle ON/OFF

- Toggle enable/disable with the [ PRESS] button at the bottom right corner.

- Select [Settings] = [Settings] > [System] = [Route]

i =

|| ol ALayerSample--= x || bl Shesta=

MRC Resufts| (2] Search Resuits| [ Design Instructions|

| Previous Layer : Bottom

[om Jo] WeRDEs:  [v) @6

=0.2, langtn =24.159988796, dX =5.

User ID : master

oute Please click next point or double dick to finish. (w

*You can create the route with the shortest path along other routes and without overlapping them

taking into consideration the DRC clearance settings.

Remove

Stat=.

H rcB:

HE Paneil

sample_doc ot

bl & & &

You can create the route without
overlapping other routes.

|| kel 4LayerSample—= x | | 1 Sheet2=

;| [@MRE Resufts| [E Search Resufts| (M Design Tnstructions|

[E—

User ID : master

oute Please click next point or double click to finish. (wids
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Semi-Auto Routing
It calculates the shortest path automatically and completes routing with one click.

Together with the Stop at First Obstacle function, it can be utilized more conveniently.

1. Open the PCB sheet, select [ Create PCB] - [Route]
2. While pressing and holding down [Ctrl] key, click the rats
3. Completes routing with the shortest path

*You can also activate the function by a click with pressing and holding down [Ctrl] key while

routing.

1]
1

|
2k
While pressing [Ctr] key, click the
ratsnest which you start routing.

It completes the routing automatically while
keeping the clearance to other routes.
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mStep 8. Types of Plane/Creating Plane
Plane, Quadcept has three types of plane.

Dynamic Plane

Specify a net name to the created plane. Dynamic plane automatically connects to objects with the
same net name according to the rule you set in the [Dynamic Plane Connection]. It also
automatically creates clearance for objects other than the specified net name and will not connect

to them.

Static Plane

It fills the area you draw. It is suitable for reinforcing the route.

1. Ribbon <Draw> - Select [ Polygon Plane] or [Rectangle Plane]
2. Check the [Plane Type] in the property window, and select [ Dynamic Plane] or [ Static
Plane]
*[ Right click 1> [ Switch Plane Type Jor you can also change it with the keyboard shortcut
[ shift + X1

3. Set points to create the outline you want draw by mouse click.

*When it is the dynamic plane*
4. Net names within the drawn area will be displayed in the [Add Net] dialog.
Specify the net names you want to connect to and click [OK]

5. [Do you want to delete unconnected plane?] message appears, select [ Yes]
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*When you edit the routing or component placement after you draw the dynamic plane, you can

update the plane by; [Double click] the plane > [Rebuild Plane] or with the keyboard shortcut

[11.

77

Plane

Plane Settings

Cutline Width 0.2

Filled Line Width

Additional Clearance |0

Met Name GMND -
Layer Too -

Plane Type
& Enable Mesh
o [1]
Pitch
Offse L

Plane Settings ]

oK

] [ Cancel
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Cutout Plane
Cutout plane is used to create much larger clearance or for the area you don't want to create plane,

etc. By placing it in the plane, that area will be cut out.

1. Ribbon <Draw> - Select [Polygon Cutout] , [Rectangle Cutout] or [Circle Cutout]

2. Set points by mouse click to draw the outline of the cutout plane on the sheet.

Create PCB Project  Window  Settings  /Samples/ImportTest/dLaye-"=mpie/4LayerSamplePCB (4f4dc77e0r5541ac0B4c2 26/4fcaed 3 1bcIBOdCB 112 f4) *
1

|1 E Component

42| g Move Origin Point

| B single Point Grounding

[ Kesp Out Arss =

£ Design Rule Area ~

X Pad | P add Net — |
| @F via |G Deiete Net +

raliel Routing

Z 5 pair Routes | [l
Route
| I Tune Route tengtns ~

(=)
(a]
&

Property

~ Aggregate Informatien =
Components o £
i EH | [ ooen | [remve]
= 0 - [ Staze
[pohes
| Drag Move Enabied
=
O GHD
Cutout Plane
| ], HE e A a

[Bcommand] [BFERe Resutts| [ DRE Resutts| [EIMAC Resuits| [ Search Resutts| [ Design Instructions|
Current Layer [Top. [} Layer Type [Sik [=] Previous Layer - Battom mm || @ GRID 254 =] & GubE[cz =] B3 E

X:26.522532 V:28.514632 Select User ID : master
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mStep 9. Board Slit

You can create a slit easily sense to enter the line.

1.  [Create PCB] - Select [ Create Board Slit]
2. Press [W] key, set the line width and click [OK]
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mStep 10. Verifying PCB (DRC/MRC)
Verify the printed circuit board before the output.

Ribbon< Completion > > [DRC/MRC] - Select [ DRC/MRC Settings]
Select [Rule Check] and set what you want to verify

Select [Apply] and click [OK]

Ribbon < Completion > - Select [ DRC/MRC]

Check the items for verification and click [ Run DRC/MRC]

5. Check the results of [DRC] and [MRC]

P w N

When there are errors, correct them and run the checks until there are no errors.

ERC/DRC settings

B @ DrRC ) »
s v | Error Tyoe Type | Cneck Contents i
k= v @ Error w | Unconnected Net Uncennected routes
() Clearance [,/ © Error T Clearance Clearance rule.
() Same Net Clearance [‘/ © Error (] Via Rules Via rule
) Route/Via |y © Error || Route wictn Route widtn rule.
J Route Length/Iscmetric Routing v © Error [+ Rouze Length/Isometric Routing | Route langin and isometric routing rule.
(3 Differential Pair v @ Error |v| Differential Pair Gap/route lengtn/tolerance of differentizl pair.
() Tear Drop [‘, © Error T Arc Route If the edge shape of routes is arc
(3 Dynamic Plane Connecticn [‘, © Error =] Dangling Route The existence of dangling routes
(3 Jumper [‘/ @ Error = Route Angle Unexpected route angle
. Test Land |v © Error v Tear dron (Tnrough) The existence of tear crop of Through
(3 Design Instructions [y © Error | Tear aron (SMD) The existence of te3r crop of SMD
N (3 Other DRC Settings [‘/ © Error lw| Tear oo (via) The existence of te3r drop of via
2 () MRC v © Error = Dynamic Plane is divided If 3 dynamic plane is divided.
B (D Rule Cneck [\/ @ Error = Pclygen/Twisted Plane The existence of twisted polygon/twisted plane.
(3 Clearance [v/ @ Error l%| Unconnected Plane The existence of unconnected olane.
- Component Clearance v © Error lv| Keeo Cut Area Keep Out viciation
(3 Reference Placement Angle [v | © Error || Therma The minimum number of thermal connection
(3 Solder Resist/Paste [v | © Error v | Test Lang The existence of test land
(3 Pac on Via v @ Error = Design Instructions Uncenfirmed design instructions.
|v @ Error lv| Egit Comoonent Edited compenent
[;/ @ Error z Annotation The differences betwesn PCB and Schematic.
“f ) ) »
——— —— () Check Clesrance of Displayed Cbjects only Maximum Numboer of Errors
0K Cancel Acply—| |
I
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DRC/DRC Results

DRC/MRC correct error points after verifying. (double click to jump into that point)

O.tludcopg File Edit Draw Create PCB Project Window Settings  /Samples/ImportTest/dlayerSampie/4LayerSamplePCB (4f4dc77e0f554e1ac084c226/414coe4 30 1bCIB0ACE 1fa24)
4

[ ] i NC Drill = = =1
[

rint NC Dl List =
Import Net | Transfer Design Instructions | Annetation Draw 30

&% Renumber Reference hiet et m-v.
I

| E® Update Compornents.

BRC/MRC | BOM | Export Netlist Pban.com

Gerber
- 1 Component Coordinate Export =

Compietion
Property

Tap,Bottom GND
TopBottom GMD

oo OO OQ
Jow e won

Tonaon, oy

~ Aggregate Information =
Components g
Pins g5
Cost o [stoee
[ Obsects =
| prag Move Ensbied
]
Jump into point
= A 8] sample.dxf
=% sample.pdf
=
=
[ 4LsyersampepCE™
DRC Results g
& Error (100) © Wamning (0) @ show Error Marks [ Upsate List | [Deiete From List| (Dispiay Settings Save File
Error; 100 {not yet: 100 approved: 0) Warning: O {nct yet: 0 approved: 0} Delete: 0
| No. ~ | check Type | Layer Target 1 Target 2 IMeasured Vall Setting Valuz| Responss Sta Comment

D

ommand | | @ ERE Results || DRE Results || B MAC Resuts| ESearch Results| r= Design Instructions

Cusrent Layer [otne [=] Layer Type [Board [=] Previeus Layer : Too

& GRID [254 =] & GuIoE [casss E3}

X:15.808281 Y¥:18.317884 Select User 1D master
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mStep 11. Export Manufacturing Data
When completed the PCB design, output the data for the manufacturer.

This section describes the method to export gerber files.

Export Gerber Data

1. Ribbon <Completion> - Select [ Gerber]
2. Select [Gerber Settings] , set and check the output content
3. Ribbon < Completion > - Select [ Gerber] > [Export Gerber]
4. Select where to save, and click [OK]
5. Open the gerber preview sheet
Gerber o EN
3 Layer ~_ /&>
& Cbjects Output Layer \(_Output Settings _\(_Aperiure
BOM
j PCB Print e ¥ | Batcn List Layer ||
) oDB++ I TopPattern 8@ Top @
) Gerber v TopSilk B o Electric @
0 NC Ol v TopSolder » Recute 7
& NC Drill List v TopPaste »* Plane @
() Component Cocrdinate v Layer2Pattem o PacStack @
v Layer3Pattern o ViaStack @
v EBcttomPattern
v BoettemSilk
« BettemScider
v BettemPaste
v Beard
[ Saveseitings ][ Read Settings ] Adao Delete &8 Show Output Layers only
=) —v— r— e——
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Quadcept Fle  Edic

| B Update Components
DAC,

Compietion

Property

% Renumber Referance

Draw Create PCB Project Window Settings  ry/Samples/ImportTest/4layerSample/4LayerSamplePCB (4f40c77e0r554e 1ac084C226/4f4cae43C 1bcoB0ACE 1fa4)

B | &

Pban.com | Draw 3D

B R i =

RC | BOM | Export Netiist | Import Net | Transfier Design Instructions | Annost

-
i

Export =

Open | [Remave]

| state

- Aggregate Information
Comganents o
Pins o5
Cost o

[ Case

| brag Move Erabied

Pansll
sample_doc.bet

samale.dxf

B 4LayerSar
Py

=)
=]
Ld

B8 Command| [BERC Resuits

DRC Resutts | [ MRC Resuits| [ Search Resuits| [ Desion Instructions |

Current Laver [Toz =]

Layer Type [Siik [=] Previeus Layer : Bottom ~mm || @ GRID[354

X:13.711129 V:57.945668

Select User ID ; master

A

Quadcept File Window Setiings ¥PROJECTS¥samurai

ce_roosi [l A

NENE
LI |

4LeyerSamplePCB_Bottol

PoeRROREREOL

LI |
L1 |

&rSampiePCB_Board

3 ¥:58.750574
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v W

Ribbon < Completion > -> Select [ NC Drill]
Select [ NC Drill Settings] and set and confirm the export content
Ribbon < Completion > - Select [NC Drill] > [Export NC Drill ]

Select where to save, name the file and click [OK]

Open the gerber preview sheet

* Perform [Print NC Drill List] or [Component Coordinate Export] as needed.

*You can also output all at once; [File] > [Batch output]

Settings

‘ Project 4LayerSamplePCB

] Laver

(3 cojects
£ BOM

(1 PCB Print
(@ ooB++

[ Gerber

(E1 NC Drill List
] Cemponent Cocrdinate

-

[ save serings || Read Seitings

- Format

Unit mim -
NumBzer of Integer Digits
Decimal Places
Zero Suppression
Offser X

Offset ¥

Long Hole Quiput Type Center + Both Ends |

& Dutput Report File

Ecenson

— ][ Cancel ][ Aoply
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Quadcept Fle  Edit Drew CreatePCB  Project Window Settings  ry/Samples/ImpartTest/dLayerSample/4LayerSamplePCE (4f4dc77e01554e 1ac084c226/4Mcacd 3c16cOB00C 1 a214)

X% Renumber Reference

[ upcate Components

B | 2

Phan.com | Draw 3D

B e e | @ - ®

MRC | BOM | Expore Netiist | Import Net | Transfer Design Instructions | Annotation | Gerber

DRC/

Cempistion

Property

- Aggregata Information

Components o

&

o5
o A
@ e
Erabed || [ &2
e
s L
@
®
3
| lE3
| IS
e
@
=L
[ IF) v
[ current Laver eniy [sestings

Previev

WAC Resuits|| L] Searen esurs| | W Design imsrucmions|

5 [=] Previeus Layer : Battom o |v] @ GRID 252

[ Bl commana | [B ERC Resules| [ DRC Resues|

Current Layer [Top l=] Las

X:13.442693 ¥:58.750974

Quadcept File Window Settings a7 %
o | B8 Eimeor~ & O4 ;
i erber preview sheet
File. User
Property 4 x5
e
DR |
PIePCE_| 3

b= Tl
|

=] Start Page * || B SLeyerssmple: I =2 X R

| Bl command | | B ERC Resutts || DRC Resutts ||l MRC Resuits || £ Search Resuits| | M Desion Instructions|

X:36.796578 ¥:56.8¢ Seiect
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Chapter 4 Handling of Data

J Annotation

J Sharing Data

J Import/Export Data (Quadcept File)
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Annotation

On Quadcept you can extract the differences, occurred through design changes, between

schematic/PCB.

This section describes forward annotation and back annotation.

Forward Annotation

Transfer the content of changes made on the schematic to PCB data

Open the file to be updated (PCB data you want to reflect the changes on)
Ribbon < Completion > - Select [ Annotation]

Select the source for annotation (Target project and file), click [OK]

A

Annotation screen will open and the annotation list will be displayed, check the content

and click [ Annotation]

Quadcept Fle Edit Draw CreatePCB  Project Window  Seftings  /Samnles/ImportTest/4LayerSampie/4LayerSamplePCB (4140c77 075546 1ac084c226/414cme43C 1bCIB0B1124)
2

&% Renumber Reference Gon) eT] et je;
S s ‘ WoE = : B 2
| [E" Update Compenents: C Drill List»
DRO/MRC | BOM | Exgort Netlist | Import Net | Tronsfer Design Instructions | Annatation | Gerber Pan.com | Draw 30
- - - s 1 Companent Coordinate Export | v

Campietion

Property

- Aggregats Infarmation. =
Select target
Components 9
e o Dreson ]
Eost 0 Layer N
[ Oajects Upaate File : [ 4layerSample/dLayerSampie! & i op = <
[ Drag Mave Enabied 1 silk |63
Source for Annotstion: [ 4LayerSampie/Circuit Bl e e
Rou @« =
Targer Project [4Lsye-Sampe o 13 kst
Pagstack (2
File @
Circuit | I3
=
Ee
O=
e L
- 2 [ IIFS )
Current Layer oniy [Settings]

Praview

He 2 B 0@ a8 @

[@ command| [BFERC Resuits| [ DRC Resuits | [ MRC Resuts| [ Search Resuits| [ Design Instructions|
Current Laver [Top. [=] Layer Tyse [Sik [=] Previous Layer : Battom & GRID [2.52 [r] & cuice
X:40.084512 ':49.154407 Select User 1D © master
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0 x

Annoration Direction

Update File : [ 2LayerSample/4LayerSampl=PCE

2

Saurce for Annotation: [im] 4LayerSample/Circuit
Annotation List

No. ~| Targst | Circuit | pce | 2poiy] Transfer content Desails.

1 GHD,FG V; E‘:u Add Single Point Grounding | € 3 — GND.FG

2 GND,FG [+ Eu Deiete Single Point Groundin | GNC,FG = { )

16 .k
—
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Back Annotation

Transfe

r the content of changes made on the PCB to schematic.

1
2
3.
4

Open the file to be updated (schematic data you want to reflect the changes on)

Ribbon < Completion > - Select [ Annotation]

Select the source for annotation(Target project and file), click [OK]

Annotation screen will open and the annotation list will be displayed, check the content

and perform [Annotation]

*Quadcept allows you to perform annotation on new and old data of schematic/PCB.

REF

Quadcept Fle Edit Draw Creste Schematic Project Window
%% panumber Reference | i Replace Symbal ta Component | [} Usdate Devica Block
15 Port Address ~ E° update Compenants {2 Update Davics Port
|# Edit Drawing Frame - | ¥ Assign Footprint

Compietion

=s/ImportTest/4LayerSample/4LayerSampleSCH (4f4dc77e0f554e1ac084c226/4f4c9bdd604092175838a437)

= & 2]
Annotation | Poan.com

T = g° Place PCB Compon®
8 Clear Placed Marks

Transfer Design Instructions |

ERC/DRC

Transfer ta PCB

Export Netlist

BOM

Property m
~ Aggregate Information 5
Components g
Select target 0 ox
(E (o) )
Taet 5 et oo
Py Anngtation Dirsction State
=:Oh It 5 it
Dt Mosie e = a Update Fils - ] 4LayerSample/Circuit
Select Cemponent Al Tnvaiid = R Rz % 5
TR e p— = 4T ark %] Source for Annotstion: [ 4LeyerSamale/dlayarsamoles
1 13
tral >
2 wee 2 Targes Project [4lsyerSampe [=]
=i ™
2 ;
ALeyerSampiePCE

U«

cHE A A& g

[B Command | [BIERC Results| [ DRC Resuits | [ MAC Results| [ Search Resuits| [ Design
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Current Layer [ [=] tayerTyoe | [=] Previous Layer: [mm |=] &g GRID[254 =] @ Gupe [127 =]
X:214.760102 ¥:180.50424 Mot Selected There is no selectsd object User ID : master
Annotation o x

Annotation Direction

Update File : [l 4LayerSample/Circuit
+
Source for Annotation: [l4LayerSamplef4LayerSamplePCB

Annotation List
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Sharing Data

Qudcept’s data are in DB (database) format and the files can be shared.

This section describes the method for sharing Quadcept directories and data with multiple people,

within a company or group.

Method for creating database

Create a new database on the server and share the database.

1.  [Settings] > Select [Environment Settings] > [System] - [Storage Space (Sharing
Settings) ]

2. Click [..] at the end line of the [Storage Space (Sharing Settings], and select where you
want to save it on the server, name the file and click [OK]
Now [Storage Space (Sharing Settings)] has been set, so click [OK]

4. Please restart Quadcept as the storage is referenced to after the restart.

*When created a new database space

To transfer Quadcept data to the [Storage Space (Sharing Settings)], you need

Settings x
‘ System | o ‘
B i Draw
el Schematic =
I PCE 8 Use Local Storage
. Route Storage Space (Sharing Settings) | ‘]
I Drawing Priarity
A Aute Backup o
] Shortcut ey Mot connected to server due to disabled setting for Using myhrea.
| Storage Space (Sharng Settings) hitps:#/guadcept com/team/storage
4l Default Environment
B [ Stroke

) Drawing Frame

= Pin/Power Supply/Port
4 Syrnbol

& Schematic

& Device Block

2 Footprint

& PCB

_ Panel

- 3D

i Property Display

[ Save Samings ][ Read Settings

[ (aF'4 ][ Cancel ][ Aoply

*In order for other multiple people to refer to the common database, please follow the above

procedure. Set the database, created at the #2 above, in the [Storage Space (Sharing Settings)], and
restart Quadcept.
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Import/ Export Data (Quadcept File)

Quadcept manages data such as directories and files in database format and saves them in bulk. So
when you want to exchange data with people outside the company or other users, you need to

[ Export Quadcept File] / [Import Quadcept File] (its extension is .qcom).

Export Quadcept File

Ribbon <File> > [Export] - Select [Export Quadcept File]
Choose objects you want to export to the "Quadcept File" from left side

Click [>1] to select export objects

i A

Click [OK] to export objects you selected.

*When [Include link objects] is checked:

Data that is linked to the object or project will also be export together.

Export Quadcept File

Filtar ‘ 3m A Objects

B o Library el lame | Updated Date | qu_—:| B
M (O] Samples ¥ | 4§ 151588 | 2/25/3013 3 151588 2/25/2013 11:17F 3 changed
B & UserDatas % 55T 7
B (& PARTS_LIB i 0503 1 5
1 CAPACITOR 4 1003 /201373770 1
I CONNECT( W 1F 1608 /2014 5:59 B 2
S pcoc || & 1505 /2014317 Pt | 7
© (@ DIODE |4 1508 /24/2012 11:43 4| 3
o1 sBD | 4 2012 24, tani 1|7 4 ] I
S VARIST 40 ] I»
T ZENMER
2 & 1c
= crP
=1 DRAM
1 DRIVER
2 EEPROM |\
(&l Include Subdirectories bl Inciuce link objects |
4
==
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Ribbon <File> > [Import] - Select [Import Quadcept File]

Choose objects you want to import from left side

Click [->1] to select import objects

Objects are added to the selected directory
* Object of all in Qcom file to click the [AIl &1 will be imported.

* If you want to import objects of the same ID, the overwrite confirmation message is

displayed. Please choose overwrite or import as another ID.

* It will be imported at the time it was added to the directory list on the right side.

Import Quadcept Fie

Import File:  C:¥Users¥

| ¥Deskiop¥gomi¥default.gcom

= | Nams

| Updated Date

| Histary

[E 4LayerSampls

5

013 8:39 PF | 50 changsd

Z| 3 changsed

| 4 1608 4
i 2012 4/24/2012 11:43 ¢ | 1 chanasd

E EE 4j24/2012 1242 1| 1 chang=d
- JoRb 4/24/2012 1143 ¢ | 1 changed
i} 4000 4/24/2012 11:43 4| 3 changed
= 4000 i

| £F 2001

<

Fiftar | & A Objects

PARTS_L15
5 CAPACITOR
| CONM
:
)

3 DC-DC
B & DICDE
d 5BD
1 VARISTOH
1 ZEMMNER

& CRU
-1 DRAM

d DRIVER

La

& 1508
i 1502

Egi 4/24/2012 11:43 ||~
60, 2/25/2013 7:34 PH
_ B 757 B
Import objects  } S
37262014 317 PP
472472012 11243 i

]

LY

| v

& EEPROM [
-

L Include Subdirectories
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On a Final Note...

We have explained how to create a schematic/PCB and export gerber data based on the workflow.
Having learned these tasks, you will be able to design a basic schematic/PCB on Quadcept.

This tutorial manual provides a basic introduction to Quadcept and covers only basic functions.

In order to use the CAD more efficiently, we not only provide support for the operation of Quadcept,
but also try our best to fulfill feature requests from customers. Our aim is to offer the daily evolving
CAD system with its users.

If you have any queries or requests, please do not hesitate to contact us.

©2014 Quadcept, Inc. All rights reserved.

This contents —including images, text, and so on —are owned by Quadcept corporation to use the
content. Quadcept cannot grant you permission for content that is owned by third parties. You may
only copy, modify, distribute, display, license, or sell the content if you are granted explicit

permission within the End-User License Agreement.

*It is prohibited to make unauthorized copies, reproductions, data tapes or data files outside the
Copyright Act.

*Please contact us for replacement if the pages are out of order or missing.
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